Guidelines for Figures
General preparation guidelines
Introduction
This page provides general information for authors creating figures to maximize the
quality of those illustrations and to prepare artwork for submission to Brazilian Journal of
Medical and Biological Research. Guidelines on specific types of figures, and on supported
file formats are also available.
In the typeset PDF figures are placed appropriately within the text, as close as
possible to their first mention in the text.
Brazilian Journal of Medical and Biological Research, if necessary, reletters authorprovided figures bu it is the author’s responsibility to ensure that figures are provided at a
sufficiently high resolution to ensure high quality reproduction in the final article.
Both acceptance of the article, and production of the final full-text web and PDF
versions will proceed more quickly if authors submit figures in accordance with Brazilian
Journal of Medical and Biological Research’s guidelines as specified in this document.
Preparing figure files for submission
Brazilian Journal of Medical and Biological Research encourages authors to use
figures where this will increase the clarity of an article. The use of colour figures in articles is
free of charge. The following guidelines must be observed when preparing figures. Failure to
do so is likely to delay acceptance and publication of the article.
•

Illustrations for publication should be provided as separate files.

•

Each figure of a manuscript should be submitted as a single file.

•

Tables should NOT be submitted as figures but should be included in the main
manuscript file.
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•

Multi-panel figures (those with parts a, b, c, d etc.) should be submitted as a single
composite file that contains all parts of the figure.

•

Figures should be numbered in the order they are first mentioned in the text, and
uploaded in this order.
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•

Figures should be uploaded in the correct orientation.

•

Figure titles and legends should be provided in the main manuscript, not in the
graphic file.
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•

Figure keys should be incorporated into the graphic, not into the legend of the figure.

•

Each figure should be closely cropped to minimize the amount of white space surrounding the illustration. Cropping figures improves accuracy when placing the figure in combination with other elements, when the accepted manuscript is prepared for publication
on our site. For more information on individual figure file formats.

•

Individual figure files should not exceed 5 MB. If a suitable format is chosen, this file
size is adequate for extremely high quality figures.

Please note that it is the responsibility of the author(s) to obtain permission from the
copyright holder to reproduce figures (or tables) that have previously been published
elsewhere. In order for all figures to be open-access, authors must have permission
from the rights holder if they wish to include images that have been published
elsewhere in non-open-access journals. Permission should be indicated in the figure
legend, and the original source included in the reference list.
Detailed guidelines for the following types of figure are available.
• Line drawings and diagrams
• Charts and graphs
• Large plot graphs
• Photographs
• Micrographs
• Screenshots
• Genetic information and sequence alignments
•
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Supported file types
The following file formats can be accepted. Detailed information for each file type can
be found by clicking on individual links.
• EPS (suitable for diagrams and/or images)
• PDF (suitable for diagrams and/or images)
• Microsoft Word (suitable for diagrams and/or images, figures must be a single page)
• PowerPoint (suitable for diagrams and/or images, figures must be a single page)
• TIFF (suitable for images)
• JPEG (suitable for photographic images, less suitable for graphical images)
• BMP (suitable for images)
Image formats - bitmap and vector
The type of file suitable for a figure depends on the content of that figure. Some
formats are better for line drawings, such as diagrams or charts, while other formats are
more suitable for photographs. There are two basic types of image format:
Bitmap images
Bitmap image files can be created and manipulated using image-editing programs
such as Adobe Photoshop or the open-source alternative GIMP. Bitmap images have the
following properties:
• consist of thousands/millions of pixels;
• have limited resolution (i.e. will not look sharp at high magnifications);
• are mainly suitable for photographs;
Bitmap file formats include - TIFF, JPEG, BMP.
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Vector images
Vector images can be created and manipulated using a wide range of programs,
including Adobe Illustrator, Macromedia Freehand, Microsoft Word and Microsoft
Powerpoint. In many cases they can also be created by printing to a PDF file. Vector images
have the following properties:
• consist of mathematically defined shapes (lines, curves, polygons).
• will retain their sharpness even when greatly magnified or when printed (see
illustrations below);
• are suitable for images containing text- or line-based elements such as charts,
graphs and diagrams;
• can contain bitmap elements;
Vector file formats include - EPS, PDF, DOC, PPT.

Figure size and resolution
Figures are likely to be resized on publication of the final full text and PDF versions to
conform to the Brazilian Journal of Medical and Biological standard dimensions, which are
detailed below.
Figures on the web:
•

width of 600 pixels (standard), 1200 pixels (high resolution).

•
•
•
•

Figures in the final PDF version:
width of 85 mm for single column;
width of 176 mm for double column;
maximum height of 230 mm for figure and legend;
image resolution should be approximately 300 dpi (dots per inch) at the final size.

Illustrations should be designed such that all information is legible at these dimensions. All
lines should be wider than 0.5 pt when constrained to standard figure widths.
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Fonts
•
•
•
•
•

Brazilian Journal of Medical and Biological Research recommends the use of either
Arial or Helvetica fonts using 12pt characters for text within figures.
Courier may also be used if a monospaced font is required (for example, in sequence
alignments).
Where Greek, mathematical or other special characters are needed and cannot be
inserted in Arial or Helvetica, Symbol is recommend.
Text should be designed to be legible when the illustration is resampled to Brazilian
Journal of Medical and Biological Research’s standard sizes listed above.
All fonts should be embedded.

Figure file compression
Figures submitted to Brazilian Journal of Medical and Biological Research should be
submitted with as small a file size as possible. Individual figure files should not exceed 5 MB.
This reduces the time taken to upload files during submission and for referees and readers
to download the complete article. Depending on the types of figure, the following guidelines
should be considered. Further details can be found in the section on figure file formats.
•
•
•
•

Vector figures should if possible be submitted as PDF files, which are usually more
compact than EPS files.
TIFF files should be saved with LZW compression, which is lossless (decreases file
size without decreasing quality) in order to minimize upload time.
JPEG files should be saved at Maximum quality.
Conversion of images between file types (especially lossy formats such as JPEG)
should be kept to a minimum to avoid degradation of quality.

Figure legends
Figure legends should be included in the main manuscript text file rather than being a part of
the figure file. For each figure, the following information should be provided at the end of the
manuscript text, following the references:
•
•

Figure number (in sequence, using Arabic numerals - i.e. Figure 1, 2, 3 etc.)
Detailed legend (up to 300 words)

Figure 4. Detection of mPER2 expression by Western blot analysis and flow cytometry.
Control: cells without transfection; pcDNA3.1: cells transfected with pcDNA3.1; mPer2: cells
transfected with pcDNA3.1-mPer2. A, Western blot analysis of mPER2 expression. The
mPER2 expression of mPer2 group cells was significantly higher than that of pcDNA3.1 group
cells and of control cells. B, Flow cytometric analysis of mPER2 expression. The fluorescence
intensity (FLI) of mPER2 expression in mPer2 group cells was also significantly higher than
that of pcDNA3.1 group cells and of control cells (P < 0.01, one-way ANOVA).
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Electronic manipulation of images
Enhancement of digital images using image-editing software can increase clarity
of figures and is acceptable practice, if carried out responsibly. It is crucial, however,
that artefacts are not introduced and the original data are not misrepresented. Details of
significant electronic alterations to images must be given in the text of the article. Original,
unmanipulated source images should be retained by the author, as Brazilian Journal of
Medical and Biological Research will support requests from referees to view the original
files.
Useful software
There are many software packages capable of converting to and from the major
graphics formats. Good general tools for image conversion and enhancement include
Adobe Photoshop (Mac/Windows). A variety of cross-platform open-source sofware is
also available for this purpose, including ImageMagick, GIMP, and ImageJ. Each of these
packages runs on Windows.
Frequently asked questions
1) How do I embed fonts in a PDF?
If your figure uses non-standard fonts, it is important to ensure that they are
embedded in the PDF. Using Adobe Acrobat Distiller, this is controlled through the ‘Job
Options’ menu. Other software for creating PDFs generally offers the option to embed
fonts in a similar. Refer to your software packages documentation.. Further instructions for
generating PDF files are available here
2) What do I do if my figure is larger than one page?
If it is not possible to scale your figure onto a single page we recommend that you
submit and refer to it as an additional data file rather than a figure. You may wish to include
some part of it (for example, a single panel or an appropriate segment) as a figure to bring
the data to readers’ attention and then refer to the complete version as the additional file.
Please remember to remove the legend from the list of figures (renumbering the remaining
figure legends, if necessary), move the legend to the list of additional files, and renumber the
citations in the text.
3) What should I do if my figure is split into separate parts, 1a, 1b and 1c?
Brazilian Journal of Medical and Biological Research requires that multipart figures
be submitted as a single composite image file. Please combine the separate parts of your
figure into one single file, if possible using the same software that was used to create the
individual parts. If the panels of the figure were created using different software, use either
Microsoft Word or a graphics-creation program to produce the composite figure and submit
as DOC, PDF or EPS. If large subsections of the figure cannot be combined (e.g. because
the final file size would be too large), please submit these as separate figures and renumber
them appropriately.

Guidelines for Figures
General preparation guidelines
4) What should I do if my figure exceeds the 5 MB submission limit?
All figures and additional files submitted to Brazilian Journal of Medical and Biological
Research must be below 5 MB in size. This file size is sufficient for very high resolution, print
publication quality images, if suitably prepared. There are a number of reasons why figure
file sizes may be unnecessarily large. In some cases, unnecessary conversion between
file types may cause figure file size to grow, so going back to the original source may help.
If your figure is a TIFF, try resaving as a compressed TIFF (more information). If it is a
photographic image, consider resaving it as a high quality compressed JPEG. If your figure
is an extremely complex vector diagram or plot, it may be necessary to convert it to a bitmap
(more information).
5) Why must I submit figure files separately from the manuscript? Why can’t I submit a
single composite manuscript file containing everything?
A number of versions of an article are required at different times: the manuscript
sent to reviewers; the version published on acceptance; the final full-text web and PDF
versions. For each of these stages Brazilian Journal of Medical and Biological Research
uses automated processes to assemble the manuscript and include and label the figures
appropriately. The automated processes require figures to be submitted separately.
If you have other questions or are experiencing a particular problem with figures, please
contact the Brazilian Journal of Medical and Biological Research production team at
bjournal@terra.com.br

Guidelines for Figures
Supported file formats

Illustrations and figures:
1. General preparation guidelines
2. Supported file formats
•
•
•
•
•
•
•
•
•
•

EPS (Encapsulated PostScript)
PDF (Portable Document Format)
DOC (Microsoft Word)
PPT (PowerPoint)
TIFF (Tag Image File Format)
JPEG (Joint Photographic Experts Group)
PNG (Portable Networks Graphics)
BMP (Bitmap)
CDX (ChemDraw)
TGF (ISIS/Draw)

3. Guidelines for specific types of figure
EPS (Encapsulated PostScript)
Most artwork-creation applications can save in, or export as, EPS format. Please
refer to the software documentation for specific instructions. Non-standard fonts should be
embedded.
EPS can be used for images produced by vector-drawing applications such as Adobe
Illustrator or CorelDraw. However, EPS tends to be a bulky file format, compared with PDF
which is a more modern and compact functional equivalent of EPS, so submission of figures
in PDF format is encouraged.
We advise that you crop an EPS image using the same software as was used to
create it (refer to the manufacturer’s documentation).
If you have problems cropping your EPS image then, as a last resort, you may
consider rasterizing it (converting from vector to bitmap format) using Photoshop, cropping
the bitmap (again using Photoshop) and submitting the resulting bitmap image in TIFF
or JPEG format. However, rasterization will typically increase file size and reduce quality,
compared with a vector image.
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PDF (Portable Document Format)
PDF is an excellent, modern image format, which can contain both vector and bitmap
elements.
To ensure hiqh quality, it is vital to choose the right settings when creating PDFs.
Whether using Adobe Acrobat Distiller or other tools for PDF creation, authors should
choose the appropriate options to create high resolution PDFs suitable for print use. This
means ensuring that all artwork within the PDF is at a suitable resolution (300 dpi or more,
at the intended final size of the figure) and that any non-standard fonts are embedded.
PDF files should be compatible with Acrobat 5.0 onwards (i.e. PDF version 1.4).
Authors should ensure that PDF figures are not password protected as this prevents
Brazilian Journal of Medical Research working with the figure and can render such figures
incompatible with earlier versions of Adobe Acrobat.
PDF files can easily be cropped using the full version of Adobe Acrobat. Select Crop
Pages from the Document menu. The Crop Pages dialog box will appear. Change the page
margins by using the up and down arrow keys for each margin (left, right, top, bottom).
Alternatively, cropping can be done by selecting the crop tool from the toolbar. Here
the cropping boundaries are set by selecting a handle at a corner of the cropping rectangle,
and dragging it to the correct size.
If you have problems cropping your PDF image then, as a last resort, you may
consider rasterizing it (converting from vector to bitmap format) using Photoshop, cropping
the bitmap (again using Photoshop) and submitting the resulting bitmap image in TIFF
or JPEG format. However, rasterization will typically increase file size and reduce quality,
compared with a vector image.
DOC (Microsoft Word)
Word is a suitable choice for submitting figures containing both vector and bitmap elements,
for authors who do not have access to a specialized drawing package. Excel charts can be
uploaded by embedding them within a Word file.
Figures should be prepared in Word version 5 or later, and be a single page.
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DOC file should be directly uploaded into the submission system. Do not convert to
JPEG or other bitmap format as this will reduce quality. Ensure that all embedded artwork
is at a suitable resolution (approximately 300 dpi, when scaled to the anticipated size of the
figure in the final PDF).
To crop a DOC file, select Print Layout from View pull-down menu. Next click Page
Setup on the File pull-down menu and reduce the page margins (Margins tab) to zero, then
change the dimensions of the page (click the Paper size tab) to match that of the image.
PPT (Microsoft PowerPoint)
Powerpoint is another good option for submitting figures containing both vector and
bitmap elements, for authors who do not have access to a specialized drawing package.
Figures must be a single slide. There should be no background colour unless it is
strictly necessary for the figure. The slide title or number should not be included. PPT files
should be directly uploaded to the site, rather than converted to JPEG or another format
that may be of reduced quality. Ensure that all embedded artwork is at a suitable resolution
(approximately 300 dpi, when scaled to the anticipated size of the figure in the final PDF).
To crop a PPT file, open the View pull-down menu, ensure that the Ruler option is
selected, and measure the dimensions of the image. Select all the elements in the slide and the
cut these elements. Then, from the File pull-down menu, select Page Setup and change the
dimensions of the slide to match that of the image. Paste the elements back into the slide.
TIFF (Tagged Image File Format)
TIFF is a bitmap format that is suitable for photographic/scanned images etc. It
supports lossless compression (LZW compression) which works especially well for flat color
images such as line art and screenshots.
We recommend that TIFFs are saved with LZW compression, as this allows higher
resolution for a given file size. If an uncompressed TIFF is uploaded, Brazilian Journal of
Medical and Biological’s system compresses it automatically. For this reason, the size
reported for a TIFF file following upload, may be smaller than the size of the uncompressed
file uploaded.
TIFF and other bitmap images can be cropped using any photo or graphics editing
package, typically by selecting the area of interest and then selecting the ‘Crop’ option from
the menu. Consult your software’s documentation for further details.
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JPEG is a ‘lossy’ bitmap format - in order to maintain a small file size, some
information in the image is discarded. In order to maintain as much image quality as
possible, JPEG files should be saved at Maximum quality. See graphic below for a
comparison of quality settings.
Low-quality JPEG image

Maximum-quality JPEG image

Low-quality JPEG image
However, resaving low quality JPEG images with higher quality settings is not
advisable, as it will only increase the file size without improving the qualityof the image
JPEG is a good choice for photographs, micrographs, autoradiographs etc. as the
compression allows much higher resolution images to be submitted, for a given file size,
with very little degradation of quality, provided the ‘Maximum quality’ setting is chosen.
JPEG is a poor choice for flat color images, line-art and screenshots as sharp edges
create visible artefacts even at maximum quality settings. Such images are better submitted
as TIFFs or PNGs.
Authors should minimize the number of times an altered version of an image is saved
as a JPEG, as every time a modified JPEG image is saved, there is some degradation of
quality. If possible, the work should be saved as a JPEG only at the end of any process of
editing the figure.
JPEG and other bitmap images can be cropped using any photo or graphics editing
package, typically by selecting the area of interest and then selecting the ‘Crop’ option from
the menu. Consult your software’s documentation for further details.
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PNG (Portable Networks Graphics)
PNG is a modern bitmap format that is suitable for photographic/scanned images
etc. It supports lossless compression which works especially well for flat color images such
as line art and screenshots. One advantage of PNG compared to TIFF is that PNG images
can be displayed in modern web browsers.
PNG images can be cropped using most photo or graphics editing packages, typically
by selecting the area of interest and then selecting the ‘Crop’ option from the menu. Consult
your software’s documentation for further details.
BMP (Bitmap)
BMP is a Microsoft bitmap format that is suitable for photographic/scanned images
etc, but is less standard and les compact than TIFF, PNG or JPEG and so is not a preferred
format, although it is supported.
BMP images can be cropped using most photo or graphics editing packages, typically
by selecting the area of interest and then selecting the ‘Crop’ option from the menu. Consult
your software’s documentation for further details.
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Line drawings and diagrams
Information represented in diagrammatic form is best submitted in a vector format
as this allows a better reproduction of line and text elements, especially when printed.
(PPT)

Supported vector file formats are PDF, EPS, Microsoft Word (DOC) and PowerPoint

Most graphics/statistical software can save PDF and/or EPS files. Please refer to the
software documentation.
On Windows users need either the full version of Adobe Acrobat, or a free alternative
in order to print to PDF.
If your diagram contains some graphical or photographic elements, these should be
included within the vector file.
If your figure contains a key, please include this within the figure. This will ensure
accurate reproduction of colour and/or hatching between figure and explanation.
In the final PDF, figures will appear as either single (85mm) or double column
(176mm). Please ensure that, when scaled to the appropriate width:
Lines are at least 0.5 pt in width
Label text is sized to ensure legibility (not smaller than 8pt)
Images have a resolution of at least 300 dpi
Charts and graphs
Chart and graphs are best submitted as a vector format figures as this permits a
sharper reproduction of line and text elements.
(PPT)

Supported vector file formats are PDF, EPS, Microsoft Word (DOC) and PowerPoint

If you are submitting a graph or chart produced in Microsoft Excel, we recommend
that you either save the chart as a PDF or copy the chart into a new Microsoft Word file and
save according to the instructions for DOC files.
If your figure contains a key, please include this within the figure. This will ensure
accurate reproduction of colour and/or hatching between figure and explanation.
Figure titles should not be included within the image file.
Please avoid hatching or patterns and instead use shading or colors as these are
more suitable for high-resolution printing.
Please ensure axis labels will be legible at our final figure sizes.
Large plot graphs
Complex plot graphs (such as those that result from Systems Biology visualizations)
may have a very large file size and should be rasterised (converted from vector to bitmap
format) using a graphics program such as Adobe Photoshop before submission, in order
to reduce the file size greatly. This will decrease the time taken to upload such files during
submission and also reduce time spent opening the file by referees and readers.
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Photographs/scans
Figures that contain only photographic data are best submitted in a bitmap format such as
JPEG, TIFF or PNG.
Many photographic images are captured as JPEG images, in which case they should be
submitted as JPEGs. When capturing the image, be sure to use the maximum quality setting for JPEG
quality, to avoid visible artefacts.
The maximum effective resolution and quality of an image is determined when the original
image is created (when the photograph is taken in the case of digital photography, or when an image is
scanned). Increasing the resolution subsequent to this, whilst maintaining the same image size, is not
advisable as it does not improve the quality of the image: the effective resolution remains the same.
Similarly, resaving with higher quality JPEG compression settings will not compensate if the image was
originally captured with low quality JPEG compression.
Final resolution of photographs should be a minimum of 300 dpi, when scaled to single (85mm)
or double column (176mm) width.
Photographs should be provided with a scale bar if appropriate.
If the photograph needs to include text, arrows or other explanatory elements, these can be
added in a graphics program, or these elements can be overlaid in Microsoft Word or PowerPoint, and
the figure submitted in that format instead.
Copy the photographic image into a new file in the chosen editing program.
Add all explanatory elements.
Once the image has been edited, save and submit the final file as EPS, PDF, DOC or PPT
depending on the program that was used to add the text. Do not reconvert to TIFF, JPEG or PNG as this
will result in loss of quality.
If photographs, X-rays or scans of patients’ body parts are included as part of the manuscript,
written and signed consent of the patient (or the patient’s guardian, where under 18) must be sent or
faxed to the editors, and indicated in the manuscript.
Medical X-rays
Medical X-rays should be treated like photographs with the following additional guideline.
If it is necessary to obscure a patient identity in a photograph or X-ray, please do not use an
overlay. Instead, edit the image itself using a graphics program, such as Adobe Photoshop.
Micrographs
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Micrographs should be treated like photographs with the following additional guidelines.
Details of the magnification should be given.
Details of any stains used and the method of preparation the sample should be given in the
figure legend or in the Methods section.
Detailed information about the microscope used should be included in the figure legend or in the
Methods section.
The type of camera, photographic software and details of any subsequent image manipulation
should be given in the article text.
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Screenshots
Screenshots are best saved as TIFF or PNG. Avoid JPEG as the compression will
needlessly reduce the quality of the screenshot image.
Screenshots should be submitted at the same resolution at which they are captured (e.g.
1024x768) - there is no benefit to resaving them at a higher resolution.
Similarly, do not convert screenshots to EPS format as this results in a larger file size with no
increase in quality.
Genetic information and sequence alignments
Figures that present either amino-acid or nucleotide sequences should be treated like
line drawings and diagrams. In the case of large, multiple sequence alignments additional
care should be taken to ensure legibility of text.
Courier is the preferred monospace font.
Ensure that all text is legible at BioMed Central’s standard figure widths.
Figures should not exceed one page in size.
If all information cannot be presented legibly in a single figure, please submit this data as an
additional file.
3D atomic structures
Figures that contain stereoscopic images such as protein structures should be
prepared according to the following guidelines.
Figures should be prepared so that the center of each stereo pair is separated by 60
mm or less.
Figures should be accompanied by details of the necessary distance between the
stereo pairs.
Images should be submitted at the size they should appear in the final print version.
Chemical reaction schemes
Chemical reaction scheme, unlike other figures, should be included within the text
and given their own sequential numbering.
Schemes should ideally fill a single column width (85 mm).
If necessary, sparing use may be made of double column schemes (176 mm).
Captions and atom labels should use a sans serif font (such as Arial or Helvetica) at 8 pt.
Schemes should be accompanied by a separate legend.
Recommended file formats - CDX (ChemDraw), TGF (Isis/Draw).

